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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
MCP3221 SAR ADC Evaluation Board. Items discussed in this chapter include:
• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Website
• Product Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes how to use the MCP3221 SAR ADC Evaluation Board as a 
development tool to emulate and debug firmware on a target board. The manual layout 
is as follows:
• Chapter 1. “Product Overview” – Important information about the MCP3221

SAR ADC Evaluation Board and the MCP3221 device.
• Chapter 2. “Hardware Description” – Detailed description of the MCP3221 SAR

ADC Evaluation Board.
• Chapter 3. “Firmware” – Information about the data acquisition process.
• Chapter 4. “Installation and Operation” – Describes how to use the MCP3221

SAR ADC Evaluation Board directly with the PC GUI.
• Appendix A. “Schematic and Layouts” – Shows the schematic and layout

diagrams for the MCP3221 SAR ADC Evaluation Board.
• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the

MCP3221 SAR ADC Evaluation Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.
Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.
For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics, to open a list of available online help files.
2022 Microchip Technology Inc. and its subsidiaries DS50003397A-page 5
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat
File paths c:\mcc18\h
Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-
Bit values 0, 1
Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING
This user’s guide describes how to use the MCP3221 SAR ADC Evaluation Board. 
Other useful documents are listed below. The following Microchip documents are 
available and recommended as a supplemental reference resources:

MCP3221 Data Sheet – “Low-Power 12-Bit A/D Converter with I2C 
Interface” (DS20001732)

PIC32MX470 Curiosity Development Board User's Guide (DS70005283)

THE MICROCHIP WEBSITE
Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE 
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notifications whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.
To register, access the Microchip website at www.microchip.com, click on Product 
Change Notification and follow the registration instructions.

CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the website at: 
https://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (November 2022)
• Initial release of this document.
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Chapter 1.  Product Overview
1.1 INTRODUCTION
This chapter provides an overview of the MCP3221 SAR ADC Evaluation Board 
combined with Arduino® Due and PIC32MX470 Curiosity Development Board.

1.1.1 MCP3221 Device Overview
The MCP3221 device is a successive approximation (SAR) Analog-to-Digital 
Converter (ADC) with 12-bit resolution in a SOT-23 package with 5 pins. This device 
has one single-ended input with very low power consumption. The device operates with 
a power supply voltage from 2.7V to 5.5V. 
Communication with the MCP3221 is performed using 2-wire I2C serial 
communication. Two communication modes are available: Standard mode at 100 kHz 
and Fast mode at 400  kHz. The converter comes with a programmable sampling 
speed up to 22.3 ksps in Continuous Conversion mode.

1.1.2 What is the MCP3221 SAR ADC Evaluation Board?
The MCP3221 SAR ADC Evaluation Board is a standard click board (with a micro-USB 
connector) that is able to acquire data and analyze the performance of the MCP3221 
SAR ADC. The acquired data set is displayed in the Hi-Resolution ADC Utility GUI by 
using serial communication between the microcontroller unit (MCU) and the connected 
PC.
The Hi-Resolution ADC Utility GUI is used to analyze and display data coming from the 
MCP3221 SAR ADC Evaluation Board. The computer running the software must be 
connected to the board using a USB cable.
A download link for the GUI can be found on the Microchip web page. For instructions 
on how to use the Hi-Resolution ADC Utility GUI, refer to the supporting documentation 
within the installation package.
System and ADC performance analyses can be done through graphical interface (GUI) 
PC tool (Hi-Resolution ADC Utility GUI), showing noise histogram, frequency domain 
(FFT) plot, time domain scope plot and statistical numerical analysis.
2022 Microchip Technology Inc.and its subsidiaries  DS50003397A-page 9
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FIGURE 1-1: MCP3221 SAR ADC Evaluation Board.

1.1.3 MCP3221 SAR ADC Evaluation Board Kit Contents
The MCP3221 SAR ADC Evaluation Board kit includes:
• MCP3221 SAR ADC Evaluation Board (EV55L49A)
• Micro USB-B to USB-A cable
• Important Information Sheet.
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Chapter 2.  Hardware Description
2.1 MCP3221 SAR ADC EVALUATION BOARD HARDWARE OVERVIEW
Figure 2-1 illustrates a detailed view into the components of MCP3221 SAR ADC 
Evaluation Board.

FIGURE 2-1: MCP3221 SAR ADC Evaluation Board.
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Input
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I2C Activity 
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USB Socket

I2C SDA, 
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2.0 to I2C/UART 
Converter

R2 Pull-up 
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R1 Pull-up 
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Low-pass Filter
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The MCP3221 SAR ADC Evaluation Board contains four main blocks, as shown in 
Figure 2-2:
1. MCP3221 SAR ADC block
2. Micro-USB 2.0 and Click connector
3. USB to I2C bridge
4. Power supply block

FIGURE 2-2: MCP3221 SAR ADC Evaluation Board – Diagram Block.

2.1.1 MCP3221 SAR ADC Block
The MCP3221 SAR ADC Evaluation Board contains the MCP3221 ADC converter, the 
R1 and R2 pull-up resistors, a low-pass filter consisting of an R4 resistor and C11 
capacitor and the J1 connector used for analog signal input. See 
Section A.3 “EV55L49A – Schematic (ADC)”.
The communication between the MCP3221 device and the microcontroller is done 
through the I2C bus, using the SDA and SCL pins. The SDA and SCL lines require a 
pull-up resistor (R1 and R2). A value of 2 k is required for 400 kHz SCL clock speed.
The input pin (AIN) is directed at the J1 connector on the MCP3221 SAR ADC Evalu-
ation Board. This enables the connection of the analog signal source to the ADC input 
channel. A low-pass filter is placed before the input pin (AIN) in order to avoid the 
aliasing effect. 
The SCL, SDA (I2C interface), RX and TX (UART interface) pins are connected to the 
Micro-USB interface.

1

2

3

4
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2.1.2 Micro-USB 2.0 and Click Connector
There are two ways to connect the MCP3221 SAR ADC Evaluation Board: 
a) Through Micro-USB 2.0 connector
b) Through mikroBUS connector. 
The first method allows data acquisition directly from the ADC, without having another 
board, via an USB to I2C bridge. The second method requires an interface with a micro-
controller unit that communicates over the same I2C bus.

2.1.3 USB to I2C Bridge
The USB to I2C bridge provides a solution to connect the ADC from the MCP3221 SAR 
ADC Evaluation Board directly to the PC. A Male USB-A to Male Micro-USB-B is 
required for this PC connection. The LD1 led indicates data transfer activity from 
MCP3221 ADC through the I2C interface.

2.1.4 Power supply
The MCP3221 SAR ADC Evaluation Board features a high-performance LDO 
(MCP1754ST) to provide the supply voltage for the MCP3221.
The MCP3221 SAR ADC Evaluation Board is powered through the USB connector 
(from the PC) or by the micro-USB connector (from the development board). The D1 
diode separates the Click and USB power supply. The LDO provides a 3.3 V for 
MCP3221 and MCP2221A. To avoid unwanted interface from the digital lines, analog 
power supply of MCP3221 is separated from the 3.3V digital power supply.
For more details, board schematics and bill of materials (BOM), see Appendix 
A. “Schematic and Layouts” and Appendix B. “Bill of Materials (BOM)”.
 2022 Microchip Technology Inc. and its subsidiaries  DS50003397A-page 13
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2.2 CONNECTION DIAGRAM
There are three options for data acquisition using the MCP3221 SAR ADC Evaluation 
Board: 
1. Through a microcontroller (using the Arduino Due Board)
2. Through a microcontroller (using the PIC32MX470 Curiosity Development 

Board)
3. Directly through the MCP3221 SAR ADC Evaluation Board, using the USB to I2C 

bridge, MCP2221A.
The microcontroller option offers two types of firmware support: PIC32MX470F512H 
(PIC32MX Curiosity Development Board) and Atmel SAM3X8E ARM (Arduino Due 
Board) microcontroller.

2.2.1 Arduino Due Board
The Arduino Due Board contains 54 digital input/output (IO) pins compatible with the 
Arduino Click Shield through which the Atmel SAM3X microcontroller is connected.
The MCP3221 data acquisition is achieved through the I2C bus, SDA/PB12 (pin 20), 
and SCL/PB13 (pin 21) pins.
Communication with the PC is done through the USB Programming port on RX0/PA8 
(pin 0), and TX0/PA9 (pin 1) pins.

FIGURE 2-3: Diagram Connection between the MCU and the MCP3221 – Arduino Due Board.
DS50003397A-page 14  2022 Microchip Technology Inc.and its subsidiaries
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2.2.2 PIC32MX470 Curiosity Development Board
The PIC32MX470 Curiosity Development Board is designed with a 
PIC32MX470F512H microcontroller. The board provides two mikroBUS™ sockets to 
expand the functionality using different Click adapter boards.
The MikroBUS 2 (J10 connector) is used to connect the MCP3221 SAR ADC 
Evaluation Board to the microcontroller pins. The MCP3221 data acquisition is 
controlled through the I2C bus, SDA/SDA1/TPD9 (pin 11), and SCL/SCL1/RPD10 (pin 
12) pins.
Communication with the PC is made through the MCP3221 SAR ADC Evaluation 
Board by using the MCP2221A, USB UART interface on RX/RPB9/U2RX (pin 14) and 
TX/RPE5/U2RX (pin 13) pins.

FIGURE 2-4: Diagram Connection between the MCU and MCP3221 – PIC32MX470 Curiosity 
Development Board. 

WARNING

Both MCP3221 SAR ADC Evaluation Board and PIC32MX470 Curiosity Development 
Board have pull-up resistors on the I2C SDA and SCL lines. In order to work, the 
resistors must be removed from one of the boards. For example, the R76 and R77 
pull-up resistors must be removed from the PIC32MX470 Curiosity Development Board.
Without this change, data acquisition does not work.
 2022 Microchip Technology Inc. and its subsidiaries  DS50003397A-page 15



MCP3221 Evaluation Board User’s Guide
2.2.3 MCP3221 ADC to MCP2221A
The MCP3221 data acquisition is carried out through the I2C interface commands 
using the MCP2221A USB to the I2C bridge.

FIGURE 2-5: Diagram Connection between MCP3221 SAR ADC Evaluation Board and the PC by 
using MCP2221A.
DS50003397A-page 16  2022 Microchip Technology Inc.and its subsidiaries
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Chapter 3.  Firmware
3.1 MICROCONTROLLER UNITS

3.1.1 MCU for the PIC32MX470 Curiosity Development Board
The microcontroller unit used in the PIC32MX470 Curiosity Development Board is the 
PIC32MX470F512H from the PIC32MX family of devices. It is a 32-bit MCU with a 
120 MHz CPU, 512 KB Flash and 128 KB RAM. 
A 20 MHz crystal is connected to the on-board PIC32MX MCU; the PIC32MX470 
Curiosity Development Board has additional support for an external oscillator. 
The PIC32MX470 Curiosity Development Board includes on-board debugger, in addi-
tion to the option to use an external debugger by connecting to the In-Circuit Serial 
Programming header.
The MCP3221 SAR ADC Evaluation Board is connected to the PIC32MX470F512H 
MCU through the I2C interface that uses pin 32 as SCL2 and pin 31 as SDA2.
Communication with the PC is done through the USB to serial UART interface through 
click interface. It used pin 22 as RX (U2RX) and pin 1 as TX (U2TX).

3.1.2 MCU for the Arduino Due Board
The Atmel SAM3X8E ARM Cortex-M3 CPU is the microcontroller used for the code 
examples integrated into the Arduino Due Board. 
The Arduino Due Board contains everything needed to support the AT91SAM3X8E 
MCU. It is based on a 32-bit ARM core microcontroller. The Arduino Due Board has 54 
digital input/output pins.
The MCP3221 SAR ADC Evaluation Board is connected to the AT91SAM3X8E device 
using an intermediary Arduino Click Shield that serves as an adapter between Arduino 
Due Board pinout and MikroBUS connector, specific to click boards. The MCP3221 
ADC is linked to the MCU through the I2C port as TW1 that uses pin 20 as SDA and 
pin 21 as SCL.
Serial data transmission is carried out through the main UART module, RX0 and TX0 
pins connected to an USB-to-serial adapter chip. The same port is used for 
programming the Arduino Due Board.
2022 Microchip Technology Inc. and its subsidiaries  DS50003397A-page 17
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3.2 DATA ACQUISITION

3.2.1 Data Acquisition Through MCU
The same data acquisition method applies to both the PIC32MX470 Curiosity 
Development Board and Arduino Due Board (Atmel SAM3X8E MCU).
Data samples are read from MCP3221 SAR ADC using the I2C communication 
protocol. Communication with the MCP3221 device is accomplished in two modes: 
executing a single conversion, on demand (single-shot conversion) or Continuous 
Conversion mode, at the maximum sample rate. 
Data acquisition proceeds on the Timer Interrupt regarding sequential conversion. Two 
bytes of data (the equivalent of a sample) are read when Timer Interrupt occurs.
The timer is used to set the period at which an ADC sample is taken. This method is 
used to set different sampling rate for data acquisition. The timer is controlling the 
acquisition speed, not the sampling speed.
In Continuous Conversion mode, the timer is stopped and a frame of 4096 bytes (the 
equivalent of 2048 samples) is read from ADC on the main loop.
In both cases, the connected MCU reads data from the ADC on I2C and fills a buffer of 
2048 bytes in length. After the I2C acquisition ends and the buffer contains the 2048 
samples, it is sent to the PC via the serial connection. When all data buffer content is 
sent, the connected MCU resumes the acquisition on I2C.
The sampled values from MCP3221 are transmitted serially with MSB first.

3.2.2 Data Acquisition through the MCP3221 SAR ADC Evaluation 
Board using the MCP2221A

Data samples are read from the ADC on I2C by using the Continuous Conversion mode 
via MCP2221A. The data acquisition process uses the Hi-Resolution ADC Utility GUI. 
The GUI sends acquisition commands to MCP2221A and the bridge devices links the 
command further to MCP3221.
In Continuous Conversion mode, a frame of 4096 bytes (the equivalent of 2048 
samples) is read from the ADC.

Note: Timer 0 is used for the Arduino Due Board code example and Timer 2 is 
used for the PIC32MX470 Curiosity Development Board code example.

WARNING

Data acquisition through the MCP3221 SAR ADC Evaluation Board with the MCP2221A 
is not accurate for data sets larger then 30 samples because of the buffer limitation of 
MCP2221A. This causes a pause in the data acquisition, which leads to data reads by 
ADC being reproduced incorrectly.
The method of data acquisition through a microcontroller is recommended for data 
accuracy and maximum sampling rate.
DS50003397A-page 18   2022 Microchip Technology Inc. and its subsidiaries
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3.3 UART COMMUNICATION PROTOCOL
The serial connection is used to send the acquired data from the MCP3221 to the PC 
at a transfer rate of 115200 baud. 
A communication protocol is implemented to work with the Hi-Resolution ADC Utility 
GUI. The board does not send data to the PC unless it receives a specific command 
from the PC.
Received commands from PC over UART are executed on the RX interrupt service 
routine implemented on the connected MCU’s firmware.
The data from the MCP3221 are sent on the UART in the form of 10 ASCII characters, 
separated by the ‘;’ character.
The main implemented commands are:
• i\r - Identify: gets the ID of the attached board (EV55L49A);
• v\r - Get FW Version: gets the version of the device firmware;
• txxx\r - Tempo Adjustment: adjusts the sampling speed (available options are 

shown in Table 3-1);
• s\r - Start: sends the data Tx/Rx cycle;
• p\r - Stop: stops the data Tx/Rx cycle

TABLE 3-1: ADC SAMPLING SPEED OPTIONS
Crt. No. Command ADC Sampling Rate (ksps)

1 t000\r 1 
2 t001\r 2
3 t002\r 5
4 t003\r 10
5 t004\r 22

Note: The ‘txxx\r’ command is sent before the Start command. If no sampling 
speed is set, the acquisition starts with the default value of 1 ksps. The 
sampling speed can only be one of those shown in Table 3-1.

Note: The ‘txxx\r’ command is not available for the method with MCP3221 
SAR ADC Evaluation Board using MCP2221A.
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Chapter 4.  Installation and Operation
4.1 INTRODUCTION
The MCP3221 SAR ADC Evaluation Board is designed to demonstrate the 
performance of the MCP3221 device using the Hi-Resolution ADC Utility GUI for PC.
This section describes how to use the MCP3221 SAR ADC Evaluation Board directly 
with the PC GUI, as well as with the PIC32MX470 Curiosity Development Board and 
Arduino Due Board.
Contains support for:
• Using the PIC32MX470 Curiosity Development Board
• Using the Arduino Due Board
• Using the MCP3221 SAR ADC Evaluation Board through MCP2221A.

4.2 GETTING STARTED

4.2.1 PIC32MX470 Curiosity Development Board Setup
Getting started with the project requires the following items:
• PIC32MX470 Curiosity Development Board
• MCP3221 SAR ADC Evaluation Board
• Male USB-A to male mini-USB-B cable
• USB-A to micro-USB-B cable
• MPLAB® X IDE
• MPLAB XC32/32++ Compiler
• MPLAB Harmony
• Hi-Resolution ADC Utility GUI.
The MPLAB X IDE, MPLAB XC Compiler and MPLAB Harmony are available for 
download on the www.microchip.com web page. 
Building the project requires the following packs and software versions, as shown in 
Figure 4-1:
• PIC32MX_DFP - 1.3.231
• XC32 - v2.50
Install the Device Family Packs (DFPs) through the IDE’s pack manager:
1. Click the Tools menu
2. Select the Packs Menu option
3. Update the available DFPs.

Note: The packs must be the specified version in order for this code example to 
work.
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Programming and debugging can be done in the following ways:
1. With the PICkit™ On-Board Debugger (PKOB), based on the PIC24FJ256GB106 

General Purpose USB Microcontroller
2. With an external debugger, such as MPLAB ICD3 (or later) or MPLAB PICkit.
In order to use the second option, remove jumper J2 to disconnect the on-board 
debugger and connect the external debugger to the J16 header.
More details about PIC32MX470 Curiosity Development Board can be found in 
PIC32MX470 Curiosity Development User's Guide (DS70005283).

4.2.2 Arduino DUE Setup
Getting started with the project requires the following items:
• Arduino Due Board
• Arduino Shield (for example Arduino MEGA Click Shield)
• MCP3221 SAR ADC Evaluation Board
• Male USB-A to male micro-USB-B cable
• Eclipse IDE, with the plug-in Sloeber for Arduino boards
• Hi-Resolution ADC Utility GUI
Two options are available for the installation of the IDE:
1. Install first the Eclipse IDE for the C/C++ project, then install the Arduino Sloeber 

plug-in
2. Install the Sloeber product first, which contains Eclipse CTD and Sloeber in one 

compressed file.
After everything is installed correctly, the Arduino section appears in the toolbar of the 
Eclipse IDE.

4.2.3 MCP3221 SAR ADC Evaluation Board to MCP2221A Setup
Getting started with the project require the following items:
• MCP3221 SAR ADC Evaluation Board
• Male USB-A to male micro-USB-B cable
• MCP2221A Utility
• Hi-Resolution ADC Utility GUI.
The MCP2221A Utility is available for download on the www.microchip.com web page.

Note: The firmware is tested only with the Arduino Due Board.
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4.3 INSTALLATION

4.3.1 PIC32MX470 Curiosity Development Board
Follow the next steps to set up the PIC32MX470 Curiosity Development Board:
1. Attach the MCP3221 SAR ADC Evaluation Board in the J10 mikroBUS socket 

from the PIC32MX470 Curiosity Development Board, as shown in Figure 4-1. 
2. Connect the USB UART interface to the PC by using the type micro-USB cable 

from the MCP3221 SAR ADC Evaluation Board to the PC.
The PIC32MX470 Curiosity Development Board is powered through the USB 
connector, by putting the jumper in the right position to select the power source from 
the J8 header.
The on-board debugger is used to program the board, by leaving the jumper in the J2 
position.

FIGURE 4-1: Hardware Connection of the MCP3221 SAR ADC Evaluation 
Board into the PIC32MX470 Curiosity Development Board.
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Once the setup is complete and all the software is installed, the MPLAB IDE can be 
started with the project. The compiler version and the packs (DFPs) must be the ones 
recommended in Section 4.2.1 “PIC32MX470 Curiosity Development Board 
Setup”. To check the version, right-click the project, select Properties, then select 
Conf: [Curiosity_PIC32_I2C], as shown in Figure 4-2.
 

FIGURE 4-2: MPLAB IDE Settings.

4.3.2 Arduino Due Board
Attach the Arduino Shield over the Arduino Due Board and the Click board in socket 
number 2 of the Shield, as shown in Figure 4-3.

FIGURE 4-3: Hardware Connection of the MCP3221 SAR ADC Evaluation 
Board into the Arduino Due Board.
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The Arduino Due Board is powered via the USB connector labeled ‘Programming’. The 
name of the port is visible on the bottom side of the Arduino Due Board. The same port 
is used to program the Arduino Due Board. 
Once the hardware is connected and the software is installed, the Eclipse IDE can be 
started:
1. Launch the Eclipse IDE, then select the Workspace
2. Click the Browser button and select the folder with the whole project
3. Next, launch the project
A few package installations are required.
1. Select the Arduino/Sloeber section, then go to Preferences
2. Select the Platform and Boards option. Then select the ArduinoSloeber field
3. Choose Arduino SAM Boards (32-bits ARM Cortex-M3) (version 1.6.12)
4. Go back and select Library Manager -> SAMDUE_TimerInterrupt (version 1.2.0)
5. Select the Arduino/Sloeber toolbar -> Click on Add a library to the selected proj-

ect -> Select SAMDUE_TimerInterrupt (the library is used for Timer Interrupt)

FIGURE 4-4: Eclipse IDE – Sloeber Settings.

To upload the firmware on the Arduino Due Board, follow the next steps:
1. Select the COM port by clicking the Project
2. Go to Properties and select the Arduino/Sloeber option
3. In the Platform folder, select the board downloaded before at “Step 3" 
4. In the Board drop-down menu, select the Programming Port option, as seen in
Figure 4-4: “Eclipse IDE – Sloeber Settings.”
5. In the Port drop-down menu, select the port used from the PC (in Figure 4-4, the 
example is COM4)
6. Next, click the Apply button.
7. The firmware can now be uploaded to the board. Select Arduino/Sloeber, then select 
Upload Sketch.
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4.3.3 MCP3221 SAR ADC Evaluation Board using MCP2221A
Connect the MCP3221 SAR ADC Evaluation Board to the PC using the micro-USB-B 
cable.
Configure the MCP2221A by using MCP2221A Utility. To do so, follow the next steps:
1. Open MCP2221A Utility. If the MCP3221 SAR ADC Evaluation Board is 

connected, the bottom of the interface displays the message Connected
2. In the Descriptor text field, type in the part number of the board, EV55L49A. The 

GUI now recognizes the board when it launches
3. Click the Configure device button; the connection status changes to SUCCESS 

in the Output field
4. Close the MCP2221A Utility.
The configuration steps are exemplified in Figure 4-5.

FIGURE 4-5: MCP2221A Utility Configuration Steps.
1

3

2
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4.4 HI-RESOLUTION ADC UTILITY GUI LAUNCH

4.4.1 GUI Launch
The Hi-Resolution ADC Utility GUI allows the user to evaluate the features of MCP3221 
device. The analog input signal of the ADC is displayed into a graph chart with the 
calculation of the main signal properties.
The GUI can be downloaded from the www.microchip.com web page. Once the 
installation is complete, the application can be launched.

4.4.2 GUI setup with PIC32MX470 Curiosity Development Board or 
Arduino Due Board

Before use, make sure that the PIC32MX470 Curiosity Development Board and the 
MCP3221 SAR ADC Evaluation Board are connected together and that the firmware is 
uploaded, as described in Section 4.3.1 “PIC32MX470 Curiosity Development 
Board” and Section 4.3.2 “Arduino Due Board”.
Once the hardware is connected, start the Hi-Resolution ADC Utility GUI. By default, 
the software recognizes the Serial Port case, the device ID and the main window is 
displayed. At the bottom of the window, a message appears with the Connection Status 
as shown in Figure 4-6.

FIGURE 4-6: Connection Status.

If the connection status is ‘Not Connected’, repeat the steps from 
Section 4.3.1 “PIC32MX470 Curiosity Development Board” and 
Section 4.3.2 “Arduino Due Board”. 

After launching the GUI, select Communication Protocol, then choose Serial Port. Click 
the Operation option, then click the Connect to a board button. The board appears on 
the right side, under the Connect button, as shown in Figure 4-7.

FIGURE 4-7: Connect Procedure for PIC32MX470F512H/Arduino Due Board.
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4.4.3 GUI Setup for MCP3221 SAR ADC Evaluation Board using 
MCP2221A

Before use, make sure that the MCP3221 SAR ADC Evaluation Board is connected to 
the PC and that the MCP2221A device is configured, as described in 
Section 4.3.3 “MCP3221 SAR ADC Evaluation Board using MCP2221A”.
Once the hardware is connected, launch the Hi-Resolution ADC Utility GUI.
In the GUI, select the Communication Protocol, then select I2C (MCP2221A). Next, 
select Operation, then click the Connect to a board button. The connected board is 
displayed on the right side, under the Select device drop-down menu, as shown in 
Figure 4-8.
 

FIGURE 4-8: Connect Procedure for MCP3221 SAR ADC Evaluation Board 
using MCP2221A.

When data acquisition from the MCP3221 SAR ADC Evaluation Board is active, the I2C 
activity LED on the Click board starts to blink.

WARNING

Data acquisition through the MCP3221 SAR ADC Evaluation Board with the MCP2221A 
device is not accurate for data sets larger then 30 samples because of the buffer 
limitation of MCP2221A.
This causes a pause in the data acquisition, which leads to data reads by the ADC being 
reproduced incorrectly.
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4.4.4 System operation
The main components of the Hi-Resolution ADC Utility GUI main window are detailed 
in Figure .

FIGURE 4-9: Hi-Resolution ADC Utility GUI – Main Window.
   

1. Control menu bar: this provides access to the File, Operation, Graph, Window, 
Communication Protocol, Help menus and the Connect button.

2. Application Control Toolbar:
a) Run button: starts or resumes the data acquisition process
b) Stop button: freezes all the data displayed on the main window and stops the 

data transmission from the MCP3221 SAR ADC Evaluation Board to the PC
c) Sampling Rate (ksps) drop-down menu: changes the ADC sampling rate.

3. Graphs section:
a) Waveform (Amplitude) chart
b) FFT (Magnitude) chart
c) Occurrences chart.

4. Info boxes: parameters normally used when analyzing electrical signals and 
ADC conversion performances

5. Connection Status box
6. FFT (Fast Fourier Transformation) Fundamental Frequency value
7. RMS (Root mean Square) value
8. Process Status Box
9. Connect button: used to reconnect the MCP3221 SAR ADC Evaluation Board.

1
2

3

4

5

6

7
8

9

Note: The sampling rate for the data acquisition process through MCP3221 SAR 
ADC Evaluation Board using MCP3221 is not configurable. The sampling 
rate is set to 11 ksps.
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In order to show the performance of the MCP3221 SAR ADC Evaluation Board, a sine 
signal is applied on the input pin by using a clean signal source. In this example, the 
parameters of the signal are:
• Frequency: 100 Hz
• Period: 10 ms
• Amplitude: 1V
• Offset: 1V

In this example, the MCP3221 SAR ADC Evaluation Board is used with the 
PIC32MX470 Curiosity Development Board.
In this example, in the GUI window the sampling rate is set at 10 ksps. After clicking 
the Run button, the GUI displayed the charts with the calculated parameters, as shown 
in Figure 4-9.

4.4.5 Data Acquisition Process
Before starting the data acquisition process, select the sampling rate from the 
drop-down list (available option: 1, 2, 5, 10, 22 ksps). If no sampling rate is selected, 
data acquisition starts with the default value of 1 ksps. Once the sampling rate is set, 
click the Run button to begin the acquisition process.

The sampling rate cannot be changed during the data acquisition process. Click the 
Stop button to stop the process, then change the sampling rate. Click the Run button 
again to resume the process.
The MCP3221 is a single-channel device with a single-ended input. Each data 
acquisition frame is 2048 samples per acquisition sequence.
For better visualization, there is a zoom-in option, available by clicking and dragging 
the mouse cursor over the desired graph. Zoom-out can be performed by using the 
Zoom-out button on each graph's axis. By default, the graphs are set to auto-scale, but 
that can be changed by selecting Manual Scale from the Graphs menu.

4.4.6 Conversion modes 
Communication with the MCP3221 device is accomplished in two modes: 
1. Executing a a single conversion (Single-Shot Conversion mode)
2. Continuous Conversion mode, with 22 ksps rate.

Available sampling rates used for Single Shot Conversion are between 1 ksps and 
10 ksps, from Table 3-1. In Continuous Conversion mode, the 22 ksps value must be 
selected.
In Single-Shot Conversion mode, the message is composed of three bytes: one with 
the address of the device (4D) and the next two represent the two bytes of data from 
the MCP3221. 

Note: The sampling rate cannot be modified during input acquisition using the 
MCP3221 SAR ADC Evaluation Board with the MCP2221A. The value is 
set at 11 ksps.

Note: Data acquisition through MCP3221 SAR ADC Evaluation Board using 
MCP2221A is only available in Continuous Conversion mode.
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Figure 4-10 shows the I2C communication data on SCL and SDA. The decode 
message is above the communication waveforms. 

FIGURE 4-10: Single-Shot Conversion Mode Waveforms.

In Continuous Conversion mode, the communication consists of an address byte sent 
by the connected MCU, followed by the 4096 data bytes, corresponding to 2048 sam-
ples, from the MCP3221. In this situation, the sampling rate is set to maximum 22 ksps. 
Figure 4-11 shows the packet format in Continuous Conversion mode.

FIGURE 4-11: Continuous Conversion Mode Waveforms.

For more information about data acquisition, check the MCP3221 Data Sheet 
(DS20001732).

Note: The Figure 4-10 and Figure 4-11 are realized by the acquisition through 
PIC32MX470 Curiosity Development Board.
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Appendix A. Schematic and Layouts
A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the MCP3221 SAR 
ADC Evaluation Board (EV55L49A):
• EV55L49A – Schematic (Block Diagram)
• EV55L49A – Schematic (ADC)
• EV55L49A – Top Silk
• EV55L49A – Top Copper and Silk
• EV55L49A – Top Copper
• EV55L49A – Bottom Copper
• EV55L49A – Bottom Copper and Silk
• EV55L49A – Bottom Silk
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A.4 EV55L49A – TOP SILK

A.5 EV55L49A – TOP COPPER AND SILK
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A.6 EV55L49A – TOP COPPER

A.7 EV55L49A – BOTTOM COPPER
2022 Microchip Technology Inc. and its subsidiaries  DS50003397A-page 36



MCP3221 Evaluation Board User’s Guide
A.8 EV55L49A – BOTTOM COPPER AND SILK

A.9 EV55L49A – BOTTOM SILK
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Appendix B. Bill of Materials (BOM)
B.1 MCP3221 SAR ADC EVALUATION BOARD - BILL OF MATERIALS (BOM)

TABLE B-1: MCP3221 SAR ADC EVALUATION BOARD - BILL OF MATERIALS (BOM)
Qty. Reference Description Manufacturer Part Number

6 C1, C3, C5, 
C6, C7, C8

Capacitor, Ceramic, 1 F, 16V, 10%, 
X7R, Surface-Mount, 0603

Wurth Elektronik 885012206052

2 C2, C4 Capacitor, Ceramic, 4.7 F, 10V, 
10%, X5R, Surface-Mount, 0603

KEMET C0603C475K8PACTU

3 C9, C10, C11 Capacitor, Ceramic, 0.1 F, 16V, 
10%, X7R, Surface-Mount, 0603

AVX Corporation 0603YC104KAT2A

1 CBL1 Mechanical, HW, Cable, USB Male A 
to USB Male Micro-B, 0.91M

Qualtek
Electronics Corp.

3025030-03

1 D1 Schottky Diode, 1PS76SB10, 
800 mV, 200 mA, 30V, SOD-323

NXP
Semiconductors

1PS76SB10,115

2 FB1, FB2 Ferrite Bead, 1 k 0603, 1LN Wurth Elektronik 742792662
1 J1 Connector, Terminal, 5.08 mm, 1x2 

Eurostyle, Through-Hole, Right 
Angle

Adam Tech EB21A-02-D

1 J2 Connector, USB 2.0 Micro-B, 
Female, Surface-Mount, Right 
Angle

FCI 10118192-0001LF

2 J3, J4 Connector, HDR-2.54 Male, 1x8, 
Gold, 5.84 MH  Through-Hole

FCI 68001-108HLF

1 LABEL1 Label, PCBA, 18x6 mm, Datamatrix, 
Assy#/Rev/Serial/Date

ACT Logimark AS 505462

1 LD1 Diode, LED, Green, 3.2V, 20 mA, 
430 mcd, Clear, Surface-Mount, 
0603

Wurth Elektronik 150060GS75000

1 PCB1 MCP3221 SAR ADC Evaluation 
Board – Printed Circuit Board

Microchip 
Technology Inc.

04-11442-R1

4 R1, R2, R3, R5 Resistor, Thin Film, 10 k 1%, 
1/16W, Surface-Mount, 0603

TE Connectivity 
Alcoswitch

CPF0603F10KC1

1 R4 Resistor, Thick Film, 100R, 1%, 
1/10W, Surface-Mount, 0603

Panasonic® - ECG ERJ-3EKF1000V

1 U1 MCHP Analog, LDO, 3.3V, 
MCP1754ST-3302E/CB, SOT-23A-3

Microchip 
Technology Inc.

MCP1754ST-3302E/CB

1 U2 MCHP Interface, USB, I2C, UART, 
MCP2221A-I/ST TSSOP-14

Microchip 
Technology Inc.

MCP2221A-I/ST

1 U3 MCHP Analog, ADC-SAR, 12-bit, 
MCP3221A5T-E/OT SOT-23-5

Microchip 
Technology Inc.

MCP3221A5T-E/OT

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4485-5910 
Fax: 45-4485-2829
Finland - Espoo
Tel: 358-9-4520-820
France - Paris
Tel: 33-1-69-53-63-20 
Fax: 33-1-69-30-90-79 
Germany - Garching
Tel: 49-8931-9700
Germany - Haan
Tel: 49-2129-3766400
Germany - Heilbronn
Tel: 49-7131-72400
Germany - Karlsruhe
Tel: 49-721-625370
Germany - Munich
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44
Germany - Rosenheim
Tel: 49-8031-354-560
Israel - Ra’anana 
Tel: 972-9-744-7705
Italy - Milan 
Tel: 39-0331-742611 
Fax: 39-0331-466781
Italy - Padova
Tel: 39-049-7625286 
Netherlands - Drunen
Tel: 31-416-690399 
Fax: 31-416-690340
Norway - Trondheim
Tel: 47-7288-4388
Poland - Warsaw
Tel: 48-22-3325737 
Romania - Bucharest
Tel: 40-21-407-87-50
Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
Sweden - Gothenberg
Tel: 46-31-704-60-40
Sweden - Stockholm
Tel: 46-8-5090-4654
UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820
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